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Engaging Content
A picture is worth a thousand words, they say. There is some 
truth to this as a tweet with images receives 150% more 
retweets than with just plain text. Tweets with animation and 
video can generate up to 9 times more engagement rates 
than simple text tweets.

One easy way to create engaging content for business 
profiles, personal brands, or entertainment is with GIFs or 
Cinemagraphs! I think of a GIF as a short animation made 
from sequenced images to share an idea. I think of a Cin-
emagraph as an image that is able to continuously loop, 
and is something that could be watched for a while without 
realizing how many times you have seen it.

These activities are designed to share technique and ideas 
for creating versatile animated content with Adobe Photo-
shop for about any purpose you can think of. I find Pop-cul-
ture inspired work to be fun to make, and easily relatable for 
a wide target-audience.

Are you ready? Let’s do some visual storytelling with anima-
tion! Let’s get GIFFY wit’ it!

I like to move it!

Project Files
You can find any of the resources I used for free 
online, but I have assembled the images I used 
into one location that can be downloaded at 
http://codepetersen.com/loot.html. Find the 
Free Content section, download the file, uncom-
press it, and you will be ready to go. Obviously, 
you can substitute any images or fonts with the 
ones I suggest. If we all made our animations the 
exact same, that wouldn’t be very much fun! 

Videos
I created video tutorials that go with these proj-
ects. Feel free to preview or follow along!
Tutorial 1: Dr Jones! YouTube Tutorial
Tutorial 2: We Have a T-Rex! YouTube Tutorial
Tutorial 3: Off the Record! YouTube Tutorial
Tutorial 4: I’m Vengeance! YouTube Tutorial
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Doctor Jones!
Introduction
We do not follow maps to buried treasure, and “X” never, 
ever marks the spot? Then how come every time you travel 
it overlays a map plotting your path in the movies? I thought 
it would be fun to start with an animation that celebrates the 
one who makes it up as he goes with this map project that 
can be used for a fun social media advertising post.

After

Before

Project Files
Deciding where to start a project can be scarier 
than a pit full of snakes. I made it easy for you! 
Find your Indiana Jones Tutorial Files folder, your 
teacher will give it to your, or you can find it on 
my website at codePetersen.com. 

Fonts
We also need a few typefaces.  One of them 
is Uppercut Angle, which can be downloaded 
free with your Adobe Creative Cloud account at 
https://fonts.adobe.com/fonts/uppercut-angle. 
The second typeface is called Adventure Sub-
titles, and can be downloaded free at https://
www.dafont.com/adventure-subtitles.font. Now 
grab your hat and get ready for your ultimate 
designing adventure!

Setting The Stage
Make a new document 1200px by 628px. Set 
the Resolution to 72 Pixels/inch. The color mode 
should be RGB Color and 8 bit.

http://codepetersen.com/
https://fonts.adobe.com/fonts/uppercut-angle
https://www.dafont.com/adventure-subtitles.font
https://www.dafont.com/adventure-subtitles.font
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Navigating the Map
Let’s fill this blank canvas on our screen with a 
picture! Go up to File then Place Embedded. 
Find and select the map image from our re-
sources folder.

The image won’t fit perfectly on our canvas, and 
that is fine. We want to keep the image scaled, 
so resize it to where the width fits the canvas. 
We don’t want to see any white space. Once 
your map is the correct size and fills the canvas, 
press enter to place the image.

TYPING TIME
Using the text tool, type “PACK YOUR BAGS FOR 
YOUR NEXT” with size 36 Adventure Subtitles 
font. Use #FEB300 for the color. Place it center, 
up towards the top of our map.

Use the same size, color, and font to type “YOUR 
JOURNEY AWAITS!” in the bottom center of our 
map.

Let’s create another layer for text at the top of 
our layers. We will use Uppercut Angle font, size 
150, and #FEB300 for the color. We’ll type the 
word “Adventure.” When finished typing, you 
will notice there is an icon with a T and a curve 
beneath it as shown here.

Click the icon then in the Style selection, select 
Arch, use Horizontal, have a +10 Bend, and a -50 
Horizontal Distortion, then click OK.

Double click on the layer’s 
name in the Layers Panel 
at the bottom right corner 
of Photoshop. Change the 
name of this layer to Map.

We can weather this map a little more. Go back 
to File and Place Embedded. Find the old pa-
per texture image from our resources folder for 
this project. Just like the map, it’s not going to 
perfectly fit the canvas, just be sure it’s scaled 
proportionately and covers the entire area. Press 
enter to place it. Rename the layer to Paper, 
and in the blending options drop down menu, 
change it from Normal to Darker Color.
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Click the move tool at the top of your tools 
bar, then use the keyboard shortcut Ctrl + “T” 
on your keyboard. You should see a blue box 
surrounding your text with 7 small squares over-
lapping the blue box edges. Hold down the Ctrl 
button, then click and drag the far let, middle 
box straight down from it’s previous location. It 
should look something like this.

On the bottom left of the gradient line, there 
will be a pointer with a square attached to it. 
Click the small square and change the color to 
#FF5A00. Change the color in the lower right 
square to #FFFFFF. If you place your cursor right 
below the gradient line in the center, your cursor 
will turn to a pointing finger. Click there to add 
a third gradient square, and change the newly 
added middle square color to #FEB300.

Now select the square above the gradient line 
on the left side and be sure the Opacity is set to 
100%. Do the same for the square on the right 
side. If all goes well, your setup should look like 
the example above.

Click OK to go back to our Layer Style menu. Be 
sure the blend mode is Normal, Opacity is 100%, 
Style is Linear, and the Scale is 60%. You will 
want to change the Angle slightly so each letter 
shows the range of the gradient. My example 
worked well at 98 degrees. When your Gradient 
Editor is open, you can click and drag your can-
vas to change the position of the gradient.

You can press ENTER, and use the move tool to 
center the text below your top line of text.

Let’s add some style to this Adventure text! Find 
your Adventure layer in your Layers Panel in the 
bottom right hand corner of your window, and 
double-click the layer to open the Layer Style 
menu.

On the left hand side of the menu, find Gradient 
Overlay. Check it, and be sure it is selected. Click 
the drop down box next to Gradient, and this will 
bring up the Gradient Editor. Click New to create 
a new gradient.
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Let’s look back at the left side of our Layer Style 
menu and select Stroke. Add a #000000 col-
ored stroke 5 pixels wide around the outside of 
the text.

One last style for this text. Select  Drop Shadow 
from the left side of the Layer Style menu. We 
want to add a shadow with a color of #000000, 
opacity of 100%, angle of 28 degrees, distance 
of 15px, spread of 100%, and size of 5px.

We will name this folder Map Contents. Now, 
let’s select the Ellipse 1 layer, the X layer, and all 
our text layers, and put them in a group we will 
name Text Content. You can always expand the 
groups by clicking on the arrows in your layers 
panel.

Now we can make a new layer above the two 
groups we just created. Use the line tool to cre-
ate a 10 pixel wide line with no fill and #FEB300  
for the stroke color.

In the Appearance section beneath the Proper-
ties panel on the right side of your window, we 
can choose the line type to make a dashed line. I 
used 2 for Dash and 2 for Gap.

Click and hold the Pen tool icon on your Tools 
panel to show other tools available. Select the 
Curvature Pen Tool and click and drag the line in 
a few locations to bend the line. It should look 
like this.

“x” marks the spot
We will make the starting point of our map by 
placing a small circle with a transparent stroke 
and a fill color of #FEB300. Our end point will 
be a 72 sized X using our Uppercut Angle font 
with the same color.

Let’s tidy up our layers a little before we get to 
our animated component. Control select your 
Paper and Map layers to select them both, and 
click the create a new group folder below your 
layers panel to put them both in a folder.
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Right click the Line 1 layer in your Layers panel 
and select Rasterize Layer. Delete the dashed 
lines that are messy or that go down the middle 
by selecting them with your Rectangular Mar-
quee tool and pressing DELETE on your key-
board.

Using our Ellipse tool, draw a circle that has 
transparent fill and a #FEB300 colored dashed 
line stroke like our line had from earlier. Place it 
above your line like this.

Rasterize the circle and clean any messy dashes. 
Control click your Ellipse layer and your Line lay-
er, then right click on one of them in your Layers 
panel and select merge layers. We will rename 
this layer as Path. Now is a good time to move 
or resize your Path layer if needed.

Each of our dotted line segments 
needs to be on their own layer. If 
you select around a dotted segment, 
then cur and paste in place, or use 
shortcut Ctrl + “X” and Ctrl + Shift 
+ “V”. That should do the trick. Do 
this for each segment, then be sure 
your layers are in order with the far 
left segment being the first layer, 
the second from the left will be the 
second of the layers, and so on, right 
down the path. I am going to name 
each layer accordingly Path1, Path2, 
Path3, etc.

I ended with 26 Path layers. Yours 
may be more or less depending on 

Animate the journey
Click the Window menu and find Timeline. 
There is a drop down arrow in a newly created 
Timeline panel. Click the down arrow and select 
Create Frame Animation.

With our first Timeline frame selected, make 
all path layers invisible by clicking the eyes to 
the left of their thumbnail preview in the Layers 
panel.

When your dotted path is no longer visible on 
your map, click the + button in your Timeline 
panel. This duplicates the selected frames. Once 
the frame is duplicated, make the Path1layer vis-
ible. Repeat this process until the entire Timeline 
is visible.

You can preview your animation by clicking the 
Play button beneath the Timeline panel. Check 
to be sure you didn’t miss any layers and that the 
animation is smooth.

If everything is good, we are going to duplicate 
our last frame and make the first layer invisible. 
We will continue this process until all layers are 
invisible again, except for the last dot (This pre-
vents a pause in the looping animation).

Your animation should show the path one dot at 
a time, then have the path disappear one dot at 
a time.

Click the Window menu and hide the Timeline 
panel.
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Preserving the map
Save your project as a PSD file in case you want 
to make changes to this project later.

To publish the animation, go to File, then Export, 
and Save for Web.
If the file size doesn’t matter, you can select GIF 
128 No Dither from the Preset. Select Forever for 
the Looping Options, then click Save.

My file was too large for the 5mb limit to post 
on Twitter, so I changed the image size percent 
to 50%, and changed the Lossy value to 10. This 
helped bring my file size down to 4.61mb.

The saga continues
Think of how you can use this animation for an 
ad or a promotion. Redesign this project as an 
ad for a travel agency, a vacation destination, or 
a guided hike/hunting/fishing trip.  How would 
you change the text?  Where would you place 
the logo? Is there a way to incorporate the brand 
with their colors? If this was posted on social 
media, what platform would work best for the 
target audience? What would the caption be? 
Give an example of two hashtags that would 
work with the post.



8

We have a t-Rex!
Introduction
Do you love dinosaurs? Would you travel to a live dinosaur 
theme park? What’s the worst that could happen? Ladies and 
gentlemen, welcome to Jurassic Park. This is a fun animated 
composition that could be used as a fun social media post or 
even a creative ad. We spared no expense!

After

Before

Project Files
Finding pictures for this project can be difficult, 
but life.... finds a way. Find your Jurassic Park Tu-
torial Files folder, your teacher will give it to your, 
or you can find it on my website at codePeters-
en.com. Now that you have everything you 
need, we can get started. Hold on to your butts.

Powering up The grid
Make a new document 1200px by 628px. Set 
the Resolution to 72 Pixels/inch. The color mode 
should be RGB Color and 8 bit.

Unless they learned to open doors
Expand the File menu, select Place Embedded 
and select the image of the car window from 
your resources folder. Resize it so it fits the width 
of your canvas.

Using a selection tool of your preference (I used 
the Polygonal Lasso Tool), select the edge pe-
rimeter of the window.

Once the window is selected, use the shortcut 
Ctrl + Shift “I” to inverse the selection, then click 
the Add Layer Mask button beneath your Layers 
panel. This should hide the contents of the car 
window.

http://codepetersen.com/
http://codepetersen.com/
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Click on the black and white layer mask thumb-
nail in your Layers panel. Go to Filter at the top 
of your screen, select Blur, then choose Gauss-
ian Blur. Set the Radius to 2.5 Pixels. Do this for 
both the mask, and then again for the window 
image thumbnail. 

Create a new layer between the Car Window 
and the Background layers. Place Embed the 
image of the trees from our resources folder. 
The image should appear to replace the con-
tents of the window. Let’s rename this new layer 
as Woods.

With the Woods layer selected in your Layers 
panel, click the Create new fill or adjustment 
layer button beneath the panel. Select Hue Satu-
ration. We will bring the Saturation down to -60 
and the lightness to -15. 

Let’s also go back to Filter, find Blur, and select 
Gaussian Blur. We will set the radius for 2 pixels 
to give the background a soft blur.

This may soften the edge of your image, so you 
may need to use the shortcut Ctrl + “T” to trans-
form and resize your image. By making the im-
age slightly larger, you can hide the exterior blur. 
Now let’s rename this layer as Car Window.
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Do-you-think-he-saurus? It’s time to add our 
dinosaur! Create a new layer right above the 
Woods layer and beneath the Hue/Saturation 
adjustment layer. On this new layer, Place and 
embed the dinosaur picture from our resources 
folder. We will rename the layer as Dino. You 
may want to temporarily hide the layers above 
and below it to easily work with the Dino image.

Using the selection tools of your choice, select 
around the dinosaur head (I used the Object Se-
lection and Polygonal Lasso tools). Click the Add 
Layer Mask button below the Layers panel. You 
can modify the mask by selecting and filling your 
selections with white or black to fine-tune the 
Dino selection. Those teeth can be tricky! 

We will rename this new layer as Reflection. 
Change the blend mode from normal to Screen 
in the Layers panel, and set the Opacity to 75%.

We can hide the border of the Reflection photo 
by adding a Layer Mask, and using a soft round 
brush with the Brush Opacity set to 30% (it’s up 
at the top of the window by the brush attributes), 
the color set to black, and lightly paint the mask 
where we want the image to blend.

Now is a good time to make any last-minute 
adjustments to size and position of the elements 
in our project. I am going to select my Dino 
layer, use the shortcut Ctrl + “L” to bring up my 
levels, and change the middle input level to 0.8 
to make my Dino a little darker.

I’m also going to move my reflection so it over-
laps the Dino just a bit more. Here is what mine 
looks like, yours may differ depending on the 
look you are going for.

Once your Dino is masked to your liking, make 
the other layers visible, then resize and position 
the Dino where you want. I am adding a slight 
Gaussian Blur (between .5 and 1) to my Dino. 

Above the Hue/Saturation layer, but beneath the 
Car Window, let’s make a new layer and Place 
Embed the image of the frightened person.



11

Time to make our final layer. We can put this 
layer on the very top above all the other layers. 
Let’s rename this new layer to Fog. Using a large, 
soft, white-colored brush (I’m going with 500px 
for the brush size), let’s lower the Brush Opacity 
at the top of our window to 80%. We can then 
click and add some fog to the window by the 
Dino’s nose. It will look something like this.

Make sure the blue scrubber handle with the red 
positioning line are at the far left of your time-
line. Click the stopwatch for Opacity. This will 
create a keyframe at the start of your timeline. 
Change the Opacity of this layer to 0% in the 
Layers panel. Move the scrubber to the :10 sec-
ond mark, and set the Opacity to 100%. This will 
add another keyframe. Next, bring the scrubber 
to the 1:00 mark we will add another keyframe 
with an Opacity of 100%. This will cause the Fog 
to hold on the window for a moment. 

Now for the Fog to slowly disappear. Let’s create 
another keyframe at the 4:00 second mark and 
set the Opacity back to 0%.

If you push the Play button in your timeline, 
you should see the Fog quickly show up on 
the window, then slowly disappear. Hopefully it 
looks like the Dino is breathing. You can adjust 
your keyframes as needed. When finished, move 
the blue scrubber back to the far left side of the 
timeline, then go up to Window, and deselect 
Timeline to hide the panel.

PRESERVING THE FOSSILS
Save your project as a PSD file in case you want 
to make changes to this later. Now let’s save our 
animation. Go to File, Export, and Save for Web. 
If I change the preset at the top to GIF 128 No 
Dither, my file size says 3.62M (yours may differ), 
which is smaller than the 5mb limit for Twitter, 
so I don’t need to change the image size, per-
cent, or anything like that. Be sure the Looping 
Options are set to Forever, then click Save. Now 
you are ready to test your file and post it online.

Expand the Fog layer by clicking the arrow to the 
left the layer name in your Timeline panel. This 
should show a stopwatch for the Position, Opac-
ity, and Style.

Turn the light off
Time to animate! Go up to Window, then select 
Timeline. Your Timeline panel will show at the 
bottom of the screen. Click on Create Timeline 
and you will see a timeline for each layer.
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Life finds a way
What fun is it to only follow a set of directions? 
You can make any change to this design you’d 
like! You can change the background, change 
the reflection to a picture of you, change the 
Dino, etc. How could you post this to advertise 
for a Dinosaur exhibit, a museum grand opening, 
or any a promotion for a local play? What fonts 
could you use with this design? What would you 
post or use for the hashtags?
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Off the record!
Introduction
There is something special about analogue audio devices. 
With the enduring novelty of vinyl records and storytelling 
of album art, this project allows us to merge it all into a fun 
animation. This can be used to promote an album, playlist, or 
even to catch the eye of those swiping through their phones 
for some possible engagement. 

After

Before

Project Files
Starting a respectable vinyl collection takes pa-
tience and time, but starting this project doesn’t 
have to. I have some images you can use to get 
started. Find your Vinyl Record Tutorial Files fold-
er, your teacher will give it to your, or you can 
find it on my website at codePetersen.com. 

HOW THE TURNTABLES
Open up Photoshop and create a new docu-
ment that is 1200 x 675px with a resolution of 
72.

NEEDLE DROP
Use the rectangle tool to draw a square. Use 
any color, but use no stroke. The size should be 
450px x 450px.

To up to File and Place Embedded, then select 
the image of the instruments from your resource 
folder. Press Enter to place. Place the cursor on 
the border between the embedded image lay-
er and the rectangle 1 layer in the Layers panel. 
Hold down the Alt key and click on the border. 
If done properly, the image should look like the 
example below.

http://codepetersen.com/
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Use Ctrl + “T” to move and shrink the shape so 
it fits better to the size of the square. It shouldn’t 
fit exactly. Be sure to keep the image properly 
scaled and do not force fit it to the exact size of 
the square.

Click File and Place Embedded. This time select 
the image of the older paper from your resourc-
es folder and repeat the same process that you 
used to fit the instrument image.

Rename your layers so that Rectangle 1 is now 
named Sleeve Shape, and the instruments layer 
is named Sleeve Graphic. Rename the old paper 
layer to Sleeve Texture. Change the Sleeve Tex-
ture’s layer blend mode from Normal to Overlay.

Double click on the Sleeve Shape layer in the 
Layer panel to open its Layer Style. We want to 
select Drop Shadow. Have the Blend Mode set 
to Normal, Color is black, Opacity is 60%, and 
Angle is 132 degrees. Adjust the Distance to 1px, 
Spread to 4%, and size to 5px.

Select the Sleeve Texture, Sleeve Graphic, and 
Sleeve Shape layers and click the Create New 
Group button below the Layers panel in the 
lower right hand corner of your window to place 
these layers in one folder. Rename the folder to 
Sleeve Contents. You can expand the folder at 
any time by clicking the arrow pointing to the 
folder in the Layers Panel to select and modify 
those layers at any time.
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Create a new layer above the Sleeve Contents 
folder and use your ellipse tool to create a circle 
that is slightly smaller than the Sleeve Shape. We 
will name this new layer as Vinyl Shape.

With the Vinyl Shape Layer selected, go up to 
Filter, Noise, and Add Noise.  A window will open  
asking if you want to convert the shape to a 
smart object or rasterize the object. We want to 
rasterize it. In the Add Noise window, we will use 
200% for the amount, and have Gaussian and 
Monochromatic selected.

Use the shortcut Ctrl + “D” to deselect the circle. 
Use the shortcut Ctrl + “L” to bring up the levels 
of the circle.

For Input Levels, we will use 100 for the left val-
ue, 1 for the middle, and 120 for the right level. 
For the Output Levels, we will keep the first value 
at 0, but bring the second value to 110.

Hold down the Ctrl button, and click in the 
thumbnail preview of the Vinyl Shape Layer in 
your Layers panel. This will select the black circle 
by placing a dotted line around the circle’s bor-
der.

Click on Filter, Blur, and Radial Blur. We will use 
50 for the amount, spin for the method, and 
best for the quality.
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Double click the Vinyl Shape layer in the Layers 
panel to open the Layer Style menu. Select Bevel 
& Emboss. We will put a Smooth Inner Bevel 
with a depth of 60%, a direction of Up, size of 
5px, and soften of 0px. Now you can exit the 
Layer Style.

Your gradient should look something like this.

The rest of your Gradient settings should have 
a blend mode of Lighten, Opacity 50%, Style set 
to Angle, Angle set to 110 degrees, and Scale of 
150%. Be sure to check Align with Layer. If you 
gradient is not aligned with your vinyl record, 
keep the Layer style window open (you may 
need to move it to the side of your canvas to 
see) then click and drag on your canvas to repo-
sition your gradient.

Right click the Vinyl Shape layer in your Layers 
panel and select Convert to Smart Object. Once 
more, let’s go back to the layer style of the Vinyl 
Shape layer.

Select Gradient Overlay. We will choose the drop 
down menu next to the Gradient. There is a plus 
button to make a new preset. If we click this, we 
can rename the preset to Record Reflection. It 
will add a gradient below our options in the drop 
down menu. If you select that gradient from the 
drop down menu, and click on the gradient pre-
view, you will open the Gradient Editor Menu.

You can add stops by clicking right beneath the 
gradient bar in your Gradient Editor. Wherever 
you click, it adds a stop. You can click and drag 
the stops to position them where you like, and 
can adjust the colors of the stops as well.
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Finally, in the Layer Style we will select Drop 
Shadow. We should keep the settings it shows 
(they should be the same as they were for the 
Vinyl Sleeve drop shadow), but I am going to 
increase the distance slightly up to 3px. It is now 
safe to click OK to close out of our Layer Style 
menu.

Rename the new Ellipse layer to Label Shape, 
and the guitar image to Label Graphic. With the 
Label Graphic Layer selected, select Image, Ad-
justments, Hugh/Saturation. Bring the Saturation 
down to -100. Select Image, Adjustments, Color 
Balance, and adjust the color levels to +50, 0, 
and -40.

Merge the Label Graphic and Label Shape layers 
together, rasterize, then convert the new layer to 
a smart object.

We can Add one last white ellipse above the 
Label Graphic Layer, and name this layer Hole. 
If we go to the Layer Style of the Hole layer, we 
can select Inner Shadow.

The Blend Mode is Normal, Opacity 90%, and 
Angle is 132 degrees. We will set the Distance to 
3px, Choke 0%, and Size to 7px.

To make our label, we will create a new layer 
above the Vinyl Shape layer, and place another 
ellipse. Let’s rename this layer to Label Shape. 
The color doesn’t matter. The shape of my label 
is 135px x 135px. Using the same technique as 
we did with the sleeve, we will now place and 
embed the image of the guitar handle. Alt click 
on the border between the layers and use Ctrl 
+ “T” to move and resize the image accordingly. 
Use the following image as a guide.
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Select all the layers that compose our Vinyl Re-
cord, and place them into a group called Vinyl 
Contents.

Check that the Foreground color is black and 
the background is white in the color selector 
squares at the bottom of the Tools panel. Click 
on the lock icon on the Background Layer to 
Unlock it. Rename the background layer to Ta-
ble.

Open the Layer Style menu for the Table layer 
and add a Gradient Overlay.  The Blend Mode 
should be Normal, Opacity 10%, and under the 
Gradient presets, we will select the Basics folder 
and choose Black to Transparent.

Set the Style to Radial and the Scale to 150%. 
You may need to click Reset Alignment to center 
the gradient.

Set the Style to Radial and the Scale to 150%. 
You may need to click Reset Alignment to center 
the gradient.

Before we animate, you may want to move your 
sleeve and vinyl to position them where you’d 
like. The following picture illustrates what my 
layout looks like.

Expand the Vinyl Contents section. You will then 
need to expand the options for the Label Graph-
ic and Vinyl Shape layers.

Be sure the blue scrubber handle is to the far left 
of the timeline, and click the stop watch icon 
to the left of the Transform option for the Label 
Graphic layer. Move the Scrubber to the 01:00f 
mark, then use Ctrl + “T” to rotate the label 
clockwise until it is upside down (holding Shift 
while rotating gives you better control).

Move the scrubber to the half-way point of your 
timeline, then press Ctrl “T” to rotate the label 
clockwise until it is right side up again. Move 
the scrubber to the 04:00f mark, rotate upside 
down, then move the scrubber to the far right, 
and rotate back to the right side up position 
again.

Turn the dial
Now if you want this spinning right round, like 
a record baby right round, we need to go up to 
Window and select Timeline. We want to click 
Create Video Timeline. You will see each layer 
and group represented in the Timeline panel.
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Drag the scrubber back to the far left of the 
timeline again (you should see the label rotate as 
you do this). Now repeat the same process but 
with the Vinyl Shape layer.

When finished, you can adjust the timeline key-
frames if you wish the speed to be more consis-
tent. Note: When you preview this, your gradient 
overlay with the vinyl record may glitch, but 
don’t worry, it will not do this when published.

Album drop
Lets save this project so we can share it with the 
world! 

Be sure to save your file as a PSD first so you can 
make changes or modify this project later if you 
wish.

Then go to File, Export, and Save for Web. This 
will open the Save for Web dialogue box.

For the file type, we will select GIF. I want to post 
mine to Twitter, so it should be 5M or smaller. If 
I change the colors to 64, that takes my file size 
down to 4.61mb. You can adjust the scale, col-
ors, and other settings to find a balance of image 
quality and file size that works for your needs. Be 
sure you have Forever selected for your looping 
options, then click Save.

SIDE B
What next? How about designing album art for 
your favorite artist or album? Create an an-
nouncement for a school band or choir concert. 
Maybe you have a podcast episode you are 
about to drop, and need a catchy animation for 
a digital announcement. A fun classroom activ-
ity could have students create a Spotify playlist 
that explains their character or motivations. They 
could design their playlist art and apply to this 
animation. What font and colors would you use? 
What imagery could you compose? Apply those 
graphics to your sleeve and vinyl label.
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I’m vengeance!
Introduction
Who doesn’t like a caped crusader?  I mean other than Joker 
or Riddler or Mr. Freeze or Bane or sometimes Superman. 
Okay, so I guess there are a lot of people who aren’t fans of 
Batman. Well I think he’s cool, so we’re making a design in 
his honor. This project will have us take an image from Un-
splash of a person in a Batman costume and a logo I created 
in Illustrator, then transform it to a dark scene with animated 
falling rain and flashing lightning in the theme of the 2022 hit 
film “The Batman” movie posters.

Before

After

Project Files
Where do we start? No, not in a dark alley, we’ve 
seen that too many times in this story. We need 
our files! Open your Batman Tutorial Files folder, 
your teacher will give it to your, or you can find it 
on my website at codePetersen.com. Once you 
have those files handy, we area ready to begin.

Setting up Our Document
Open up Photoshop, and create a new docu-
ment that is 600px by 900px. You can use the 
image in the next column to help you. We can 
bring our hero into the picture by going up to 
File -> Place Embedded. Navigate to where your  
tutorial files are saved, and find the Batman Pho-
to by Lukas Denier on Unsplash.

Resize the Batman image as needed. Be sure 
to keep it scaled. Batman is never going to save 
Gotham City if he’s stretched and distorted. 
Alfred would never let him leave the cave look-
ing like that. It’s okay to have the image larger 
than the canvas. I made mine large enough to 
hide the pole on the left side of the image. Let’s 
rename this layer we created as Batman.

http://codePetersen.com
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I Am The Shadows
Select the sky with your magic wand tool. You 
may need to change the tolerance at the top 
of your Photoshop window so that it selects 
the entire sky. Once you have the sky selected, 
we want to use the shortcut Ctrl + Shift + “I” to 
inverse your selection. Find and click the Add 
Layer Mask button beneath the Layers Panel in 
the lower right corner of your window. This will 
hide the sky.

In the Layers Panel, select the Batman layer 
thumbnail (not the black and white mask), and 
use the shortcut Ctrl + “L” to bring up your levels. 
Bring the right output level (white arrow) to the 
left at 68 or to your liking.

Unlock the background layer by clicking on the 
lock in your Layers panel. This will change the 
name of the layer to Layer 0. Be sure your col-
ors in your color selector beneath your tools are 
black for the foreground color and white for the 
background color.

Double click on Layer 0 in your Layers panel. 
This will open up the Layer Style menu. Select 
the gradient overlay option in the left hand 
side of the menu. Be sure it is highlighted and 
checked. Set the Blend mode to Normal. Set the 
Opacity to 100%. In the drop down menu from 
Gradient, find the Basics folder and select the 
gradient that goes from black to transparent (It 
looks like black fading to checkered in the pre-
view). For the Style, select reflected. You can set 
the angle to 130 degrees or to your liking. The 
scale can be 150% or to your liking. This is a Lay-
er Style, so you can always go back and change 
it.

Click on the File menu and select Place Embed-
ded. Find and select the Bat Logo file saved in 
your resources folder. Place the logo on Batman 
accordingly.
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With the Bat Logo layer selected, click on Filter, 
then Blue, and Gaussian Blur. Select 2.5 Pixels for 
the radius.

Create a new layer above the rest of the layers 
and name it Rain. With the Rain layer select-
ed, use the shortcut Shift + Backspace. Under 
the contents from the Fill pop-up menu, select 
Black. Go back up to Filter, select Noise, then 
Add Noise. We want 40% for the amount, Gauss-
ian for Distribution, and check the box next to 
Monochromatic and click OK.

Now we will go back to Filter, select Stylize and 
Wind. Select Blast.  Repeat the Stylize Wind pro-
cess one more time.

Let’s go back to Image and Image Rotation, and 
now select 90 degrees counter clockwise to 
restore the orientation of our image. Invert the 
colors of the rain by using the shortcut Ctrl + “I”.

We want this to be a seamless vertical pattern, 
so lets click on Filter, Other, and Offset. Change 
the Vertical Slider until you see a faint line across 
the grains.

Click on Filter, select Blur, and click Blur. Do this 
twice.

Click Image and select Image Rotation, then 90 
degrees Clockwise.



23

Select your Spot Healing Brush tool, click and 
drag all the way down the faint line. When you 
release the mouse button,it should hide the line. 
Now you know how to make a repeating pat-
tern!

Select Edit, select Define Pattern, and name the 
pattern Batman Rain.  Click the eyeball to the left  
of the Rain layer to hide it.

Create a new layer above the Rain layer and call 
this layer Rainfall. Use Shift + Backspace to bring 
up the Fill menu and select 50% Gray from the 
drop down menu.

Double click the Rainfall layer in your Layers 
panel to open the Layer Style menu. Select 
Pattern Overlay on the left side of the menu. Be 
sure it is checked and highlighted. For the Blend 
Mode, select Screen. Set the Opacity to 100%. 
In the Pattern drop down, find your Batman Rain 
pattern. The Angle should be 0. Scale is 100%.

In the Layer Styles, select the Blending Options 
at the top on the far left side of the menu. Drop 
the Fill Opacity down to 0%.

Create a new layer above the other layers and 
name it Red Overlay. Use Shift + Backspace to 
fill, and in the Contents drop down, select Color. 
Let’s use #DB0000 for the color value and click 
OK. Set the Blend Mode in the Layers panel from 
Normal to Multiply. If that doesn’t strike terror in 
the hearts and minds of Gotham’s worst, I don’t 
know what will.

Holy Ben franklin batman
Let’s animate our rainfall and lightning! Go up to 
Window and select Timeline. At the bottom of 
your screen a Timeline panel will appear with a 
button that says Create Video Timeline. When 
you click this button, you will see a timeline for 
each of your layers. Select your Rainfall Layer in 
the Timeline panel, and click the arrow pointing 
to the word Rainfall to expand the options.

Click the stopwatch to the side of the word 
Style. This should add a Keyframe (a small dia-
mond) in the left side of the timeline. Above the 
timelines, you will see a blue scrubber or blue 
handle with a red line beneath it. Click and drag 
the blue handle until it’s all the way to the right 
side of the timeline.
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Right click on the Rainfall layer in your Layers 
panel and select Convert to Smart Object. You 
may need to change the Blend Mode in the 
Layers panel back to Screen if it switched to 
Normal. Using Control + “T” to Transform you 
can rotate your Rainfall layer and adjust the size 
so that it covers the canvas to change the angle 
of the rain.

Double click the Rainfall layer to open the Layer 
Style menu. In the Layer Style menu, select Pat-
tern Overlay on the far left side. Move the Layer 
Style window to the right of the canvas so you 
can see your picture and the menu.

With the Layer Style window still open, move 
your cursor to the top of the canvas on the left. 
Click the top of the picture and drag straight 
down to the bottom of the screen (holding Shift 
while doing this can help drag straight down). 
You will see the rain pattern move down as you 
do this. Repeat that process for 10 total times 
(less if you want the rain to fall slower or more 
if you want it to fall faster). Click OK in the Layer 
Style window and it will add a second Keyframe 
on the right end of your Rainfall timeline.

You can test the speed of the rain by clicking on 
the play button in the Timeline panel.

Add a new layer above the rest, and name it 
“Black”. Use the shortcut Shift + Backspace and 
fill contents with Black. Change the blending 
style from Normal to Overlay in the Layers panel.

Go back to our timeline and expand the con-
tents of our Black layer. This time we will move 
the blue scrubber handle to the 1:00f mark 
and click the stopwatch icon next to the word 
Opacity. Move the scrubber a few clicks to the 
right, click the diamond shape icon next to the 
stopwatch. Change the opacity to 0%. Move the 
scrubber to the 2:00f mark, add a keyframe with 
an opacity of 100%. If you test the animation 
with the play button again, you can see it looks 
like flashing lightning. You can add as many key-
frames as you’d like and space them according-
ly. Below is what worked for me. The keyframe 
before the 4:00f mark used an Opacity of 50% 
instead of 100%, but again, you can adjust yours 
to your liking. 

Once finished with the timeline, move the blue 
scrubber back to the far left, then select Window 
at the top of the screen and unselect Timeline.
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Now for some typography! Create a new layer at 
the top and select it. Using the Horizontal Type 
Tool, type “BATMAN”. For the color, use the value 
#DB0000. For the font, use Haettenschweiler, 
or a font of your choice. Have the text size be 
140, or to your liking. Place the type in the lower, 
center of your image.

Batman saves twice
Your files, like Gotham, are worth saving. Be sure 
to save your project as a PSD file so you can 
make changes layer if you’d like. You are now 
ready to publish your animation.

Go up to File, Export, then Save for Web. This 
opens the Save for Web dialogue box. Use the 
GIF preset with 16 colors and No Dither.

Depending on where you want this image post-
ed, you may want to change the image settings 
or sizes. For example, Twitter only accepts file 
sizes of 5mb and smaller. I am going to change 
the Image Size percent to 45%. You will see that 
this lowers my file’s size to 4.64mb. You can 
adjust the sizes and settings here accordingly to 
where you find the right balance of quality vs file 
size that works for your purpose.

If you’d like, you can do the same with the word 
“THE” but using size 62 Haettenschweiler, placed  
center and right above the word “BATMAN”. 
Select your two text layers in the Layers panel, 
and drag them down in the order so they are 
beneath the Rainfall layer. 

Click Save... Then choose where you want your 
file saved and name it accordingly. Once it is 
done exporting, double click on your file to pre-
view your Batman Cinemagraph!
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Batman returns
What other elements would you like to add to 
your poster? Cast from the movie? A quote from 
the film? It might be fun to use a Riddler quote 
with an anarchist style typeface.

Or maybe, you’ve had enough Batman. You can 
use this same technique to create an animat-
ed book cover, movie poster, or graphic for a 
school/community play. Try creating a promo-
tional Cinemagraph with a different color over-
lay, and different character silhouettes.

Now go make your graphic. It isn’t the graphic 
your client needs, but it’s the graphic your client 
deserves.
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Thank you!
I appreciate you
Thank you for taking the time to look at my eBook. I hope 
you had as much fun putting these projects together as I 
did. Digital designs have such a wide application for busi-
ness, marketing, branding, creativity, and are just plain fun. I 
sure appreciate any feedback you can give, and would love 
ideas for creating more resources. Find me at my website 
codePetersen.com!
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